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About MESA II

Modular Editing System by AKAI

MESA II is the computer based software system that provides the centralized control of

hardware operation and data transfer in a wide range of AKAI Samplers and digital

recorders, etc. from a single screen on the PC (Windows95).  It currently supports XL-

series Samplers, S2000, S3000XL, S3200XL and CD3000XL.

Using a computer to control external hardware devices has a number of advantages.

For instance, samples and programs can be loaded from any device into the PC’s

memory and manipulated, played, and stored on any device of the user’s choosing.

The audio and parameter data can be backed-up, or saved, onto the PC’s disks, and

reloaded at later time.

While those external devices like the Samplers can be operated from their own front

panel, most of them offer only small screens for the cost reason and such.  The power

of MESA II lies in enabling access to the functions of such devices on a much larger

screen via a graphical user interface: users use the mouse to select functions, set

levels and parameter data via buttons, sliders, knobs and faders on the screen.  Audio

Editing, Sample Editing, Program Generation, Storage, and File Manipulation can all

be controlled from the PC.  The convenience of a large screen graphical user interface

not only saves time and effort but offers a finer level of control to manipulate sounds

and programs.

Centralized control of

various hardware de-

vices and data trans-

fer

Save time and gain

finer level of control on

a large screen with a

top-notch Graphical

User Interface
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Getting Started

How to install MESA II

Double click on “MESA II.exe” icon to start setting up. Specifying where the MESA II to

be installed completes the installation.

System Requirements and Set-Up

The following are required to run MESA II.

* Windows95 machine (Pentium 166MHz or faster is recommended)

* 8MB or more spare RAM memory (16MB recommended)

* Sound card with its Windows95 driver

* SCSI card with its Windows95 driver

* Graphic card capable of 800 x 600 (SVGA)

* 6MB or more free hard disk space

* A mouse

To use MESA II in a SCSI environment, the SCSI board is required for the system

without SCSI board.

How to setup MESA II in a SCSI environment

SCSI (Small Computer System Interface) is a fast communication protocol designed

primarily for the data transfer of computer.

Boot-up procedure is as follows;

* Turn off your PC and Samplers, and connect them with standard SCSI

cables.

* Turn on the Samplers.

* Turn on the PC after the Samplers are booted up fully.

Your PC requires to have SCSI supported, and some of the Samplers offer SCSI board

as an option.  In this case, the SCSI board has to be installed in the Sampler.

While a total of 8 SCSI IDs from 0 to 7 are provided, the PC uses 7 (for PC itself),

leaving you 7 IDs for external devices.  AKAI Sampler is usually set to ID 6.  All other

devices need their own individual SCSI IDs.  If more than one device shares the same

SCSI ID number, the system will freeze or malfunction.

A further potential problem is incorrect SCSI termination.  Ensure that you have termi-

nated your SCSI system correctly.  Most of system freezes are caused this way.

If you turn an external SCSI device on after the PC is turned on, then you must wait for

it to fully boot up before you do anything on the PC.  If you do not and the PC tries to

access SCSI during that time, then the PC may freeze.

Without conforming

to these require-

ments, MESA II may

still boot but may

cause unpredictable

behavior as low in

memory, call unsup-

ported function, etc.

Audio data transfer

from Samplers to the

PC needs SCSI to

run

Faulty SCSI cables

cause some trouble,

use high quality

cables

Note on SCSI con-

nection
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About MESA II developer team

MESA II has been developed by Andy Bull of Living Memory, London and Chris Parks

of London as part of a worldwide AKAI professional team of developers residing in

Japan, Britain, and the U.S.A.

Support

This software is also available free of charge when it is downloaded from our web site

(http://www.akaipro.com).  Therefore, we offer no guarantee for this software.  Accord-

ingly, the technical backup and support on this software are not available in principle.

However, your comments and suggestions on this software are welcomed.  Please

forward them to AKAI professional M.I. Corp. or your local AKAI professional distribu-

tors.

Software Protection and Copyright

The copyright of this software is owned by AKAI professional M.I. Corp., Living Memory

and Chris Parks.  It is prohibited to copy, for the purpose other than making personal

backups, or distribute this software without prior permission.

AKAI professional M.I. Corp., Living Memory and Chris Parks disclaim all the responsi-

bility for all the harm or damage to users caused from the use of this software, and

make no compensation for them.

Windows95 is registered trademark of Microsoft Corporation. All other product and

company names are the property of their respective owners.
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New Functions

MESA II is a major update from earlier versions of MESA PC.  The interactivity of the

program has been drastically enhanced, resulting in an easier-to-use interface for pro-

fessional sound engineers while offering an extended set of sophisticated functions for

the ‘power user’.

Editors

MESA II now combines the two separate applications of Sampler Editor and Wave

Editor into a single MESA II application.

Editors, the Sampler Editor and Wave Editor, are now the main access points in MESA

II.  You may choose to disable the display of Editor you do not need by setting in

“Configure Editors . . .” accordingly.

Sampler Editor

* Quick Access Window - as found in the MESA II for Macintosh, the key

parameters of the programs and keygroups can be manipulated in a single

screen.

* Smapler Explorer - Sampler Memory window and Disk window are now

combined into a single window to simplify the file system and operations.

This window allows to save and load the data to and from the floppy disk,

SCSI device of the sampler and computer, and to view the contents of the

sampler’s memory and disk.

* EB16 Window/FX Filing Window - now allows to control the EB16. The

selection of Effect Set and setting the parameters of each Effect are made

in EB16 window and the change of Effects Name is made in FX Filing

window.

Wave Editor

New Wave Editor Tools and functions included:

* Editing of stereo samples - samples in the sampler (as two mono samples

“-L/-R”) and stereo wave file recorded by the PC’s sound recorder are

now recognized as stereo file when drag and dropped into the editor;

* DSP - “Expander Limiter” and “Time Stretch” functions have been sup-

ported.

Tool Bars

The frequently used functions such as, display of various windows in Sampler Editor,

Play and Stop of sound in Wave Editor, etc. are now grouped into one Toolbar to allow

you to use various functions quickly.

Access to AKAI’s Home Page

A simple execution of “Go to AKAI Home Page” will connect you to AKAI’s Home Page

via Internet.

A much neater con-

ceptual operability

Editors made for

specific purposes -

select Editors you

need to work with

New Tools

Load several wave

samples and cut and

paste between them

Access all functions

from a single screen
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Tutorial

Application Made Easy to use

This simple Tutorial is written to provide a quick 'hands-on' overview of MESA II.  It will

take about a half an hour to work through.  This chapter, by the way, is described on the

assumption of that the PC and Sampler are connected without having any trouble, and

MESA II has been installed properly.  For the set up of MESA II, refer to "Getting Started"

Chapter.

In particular, you will learn to

1. start MESA II;

2. connect to a Sampler;

3. load disk data into the memory of Sampler;

4. move sample data into your PC;

5. edit a sample;

6. save a sample;

7. create a new program;

8. assign a single sample to a program;

9. create a more sophisticated program; and

10. save a program

Step 1: Starting MESA II

* Select Mesa in the Startup menu of the task bar or double click on the MESA II icon.

MESA II title appears.  After loading the application software, one or several MESA

windows will open up - MESA II opens up where it was Quit the last time.

You should see the menus such as File, Edit, Editors on the menu bar, and depending

on which Editor happens to be selected, some further menus such as Sampler/Win-

dows (Sampler Editor) or View/DSP (Wave Editor) will appear.  Under the menu bar,

you will see the Toolbar, depending on the selected Editor, with the corresponding Tool

icons for windows and functions will appear.

Note that even when there are no windows open, one of the Editors will be active and

marked with a tick under the Editors Menu.  On the menu bar, the Menu for this Editor

is shown.

Step 2: Connecting to a Sampler

* Select the "MesaSamplerEditor" from the Editors Menu, and select the "Find Sam-

pler..." from the Sampler Menu.

You should see the message box showing the sampler conneted. Click on the "Con-

nect".

You will find it easier

to digest this manual

if you first work

through the Tutorial

Make a short-cut of

MESA II and place it

on the desk top for

quick start

If you cannot con-

nect to your Sam-

pler, see 'How to

setup MESA II in a

SCSI Environment'

above
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This shouldn’t be necessary as the connection to the sampler has already been estab-

lished when the system is powered up.

* Select the "MesaSamplerExplorer" window from the menu bar and click on "Memory"

at the left column.

The AKAI Sampler contains the TEST PROGRAM and 4 sample data in default.

Check if they are displayed on the right column of the Sampler Explorer Window.

Step 3: Loading disk data into the memory of Sampler.

* Insert the sample floppy disk included with AKAI Sampler into your Sampler.

* Select the "MesaSamplerExplorer" from the Windows Menu.

* Click on the "Floppy" shown at the left column of the Sampler Explorer Window.

This accesses the Sampler's floppy disk, and the contents of disk will be shown at the

right column of the Window. (If the SCSI [id 5 (0~7)] is clicked, the SCSI devices (hard

disk, CD-ROM drive, etc.) connected to your Sampler will be accessed.)

* Click the program or sample on the window to select the one you want to load.

The selected item will be shown reversed.  If you want to select several items, click

them while holding the Shift key pressed.

* Drag the selected items and drop them on the "Memory" at the left column.

The selected items are now added to the Sampler's Memory.  You may also load them

selecting the type of load from the menu shown by right clicking on the selected item (In

this case, you can clear the old samples in the Sampler's Memory before loading the

new samples).
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Step 4: Loading sample data into the computer memory

To load the sample data from your Sampler memory to your PC’s memory;

* Select the "MesaWaveEditor" from the Editors Menu.

A "Wave editor file list" will appear. If not, select the "File list..." from the View Menu.

* Select a sample from the Sampler Explorer Window and drag and drop it into the "Wave

editor file list" Window.  To load stereo samples, select both left and right (-L/-R) samples

and drop them.

The Wave Editor Window is now filled with the selected samples' wave form.

* Press the Spacebar.

The samples on the window will be played.  To stop playing, press the Spacebar again.

Since these samples are on the PC’s memory, they will be played from the speaker

built in the PC.

Step 5: Editing a sample

You can edit a sample using a DSP (Digital Sound Processing) function in the Wave

Editor.  DSP functions work only on the selected part.  Selecting the whole sample

(Select All in Edit Menu) or selecting a part thereof renders the DSP Menu active, i.e. its

color changes from gray to black.

* When the Cursor is placed on the Wave Editor screen, the shape of Cursor is changed

to an "I" beam shape. Drag it on the wave form to select the part of a sample.

The selected part is displayed in reversed color, and only the selected part will be

played when the Spacebar is pressed.  To adjust the right and left margins of the se-

lected part, drag the left or right point while pressing the Shift key down.  Click any-

where outside the selected part to deselect.

* Select "Reverse" from the DSP Menu.

The selected part is now reversed.  Only the edited part will be played when the Spacebar

is pressed.
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* Click anywhere outside the selected part of wave form in the Wave Editor Window.

Everything will be deselected, and pressing the Spacebar will play the whole sample.

Try the same steps for other selections and other DSP functions.  If you want to use the

Wave Editor more seriously, you will have to use the Zoom, Markers, and other func-

tions as described in the "Wave Editor" Chapter.

Step 6: Saving a sample

To save the sample edited by the Wave Editor to the Sampler Disk;

* Open the Sampler Explorer Window on the Sampler Editor and select the "Memory".

Keep the Sampler Explorer Window visible even when the screen is changed over to

the Wave Editor.

* Place the Cursor on the Drag icon at the top right corner of the Wave Editor.

The Cursor is now changed to the shape of a hand.

* Drag the wave form on the Wave Editor Window, and drop it on the Sample List of the

Memory Window (Dragging the sample shown in the Wave editor file list and dropping

it on the Sample List in the Sampler Explorer will do the same).

Now the sample has been sent to the Sampler's Memory.

* Select the "Floppy" on the Sampler Explorer.

Check if there is a floppy disk to save in the Sampler.

* Drag and drop the sample from the Sample List to the "Floppy".

Now the sample is saved on the Sampler disk.

You may also save them selecting the type of save from the menu shown by right

clicking on the selected item.

Next, to save the sample edited on the Wave Editor onto the hard disk of your PC;

* Select the "Save" from the Wave Editor File Menu.

You will be prompted to select the saving location and saving type as you save.

You may also drop the sample from the Wave Editor Window directly onto the Desk Top

of the PC using the drag icon.

Furthermore, the sample on the Sampler can be saved directly to the PC’s disk.

* Select the "Memory" on the Sampler Explorer and right click (anywhere within the win-

dow) to see the menu. Choose the "Set Export Directory" in the menu and select the

saving location. Make a right click on the sample you want to save to see the menu and

select the "Export Selection..." from the menu to complete the save.

You may also drag the sample you want to save and drop it directly onto the Desk Top

of the PC.

Step 7: Creating a new program

To create a new (empty) program;

* Open the Sampler Editor Window and select the "New Program..." from the Program

Menu (You may use a right click at the right column while the "Memory" is being se-

lected on the Sampler Explorer and select the "New Program..." from the menu).

* Input the name as a dialogue to allow you to name the new program appears.
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* Input "TEST" and select OK. Confirm the new program has been added in the sampler

memory.

We will next assign samples (each with a different key span) to this program, and play

it in the Keyspan Window.

Step 8: Assigning a single sample to a program

To assign a sample to the program "TEST" created in the previous section;

* Select the "TEST" program on the Program Selector Window (If this window is not

shown, select the Program Selector from the "Windows" Menus (or press  Alt + P) in the

Sampler Editor).

* Select the Keyspan (Alt + K) from the "Windows" Menus, and open the Keyspan Win-

dow.

* Select the sample "SINE" from the pull-down menu in the Velocity Zone 1.

There are other alternatives to assign samples to programs: you could use the Control

Center Window, Keyspan Window, or the Quick Access Window.  The quickest and

most simple way to create a one-sample program is to use the Quick Access Window.

Try playing the program now.

* Click on the Keyboard on the Keyspan Window with the mouse.

You may directly play the Sampler with the external MIDI Keyboard connected to the

Sampler.

Step 9: Creating more sophisticated programs

To create a more sophisticated program with several samples assigned in the Sampler

memory, we need to add further keygroups containing further samples to our program.

Now open the Program Selector Window by selecting the Program Selector (Alt + P)

from the Windows Menu to select the program and keygroups.

To add a keygroup to the "TEST" program which we have just created;

* Click on the "+" sign.



10  Tutorial MESA II

The keygroup 2 has been added.  When editing only the keygroup 2, click the number

2 in the Program Selector Window.

* Open the Control Center Window by selecting the Control Center (Alt + C) from the

Windows Menu. This gives you full control over all program parameters. The Control

Center Window is divided into several sections, each incorporating a selection menu

seen with right click, allowing you to set different parameter in each section. When not

only the Control Center Window but the windows other than the Program Selector

Window is opened, the Program Selector Window opens up automatically.

* Select the sample "SQUARE" from the pop-up menu of Velocity Zone 1 Section on the

Control Center Window.

Now the new sample is assigned in the keygroup 2.  If you switch back to the keygroup

1, you will see the sample "SINE" in Velocity Zone 1.

If you now play the program, you will hear both samples playing together on all notes.

Next the samples are assigned to the specific ranges of the keyboard to create the

Keyboard split;

* Open the Keyspan (Alt + K) Window.

2 keygroups are shown on the screen and the samples "SINE" and "SQUARE" are

assigned on each Velocity Zone 1.

* Drag the left half of span bar of the keygroup 2 with the mouse, and slide it up to C4.

At the left of Window, the note number which has just dragged is shown.

* Drag the right half of span bar of the keygroup 1 with the mouse, and slide it down to

B3.

Now the sample sound played will be changed over B3 and C4.

Now let's play this program.  At the lower half of the Keyboard, "SINE" is played, and at

the higher half of the Keyboard, "SQUARE" is played.  With repeating this procedure,

many more keygroups can be created in the Program Selector Window.
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The whole program setting and the sample parameter control can be performed only in

the Control Center Window.  Here, we will make a wide spread stereo program using

only one sample, "SAWTOOTH".

* Select the "New Program" from the File Menu.

* Name the program "STEREO" as the dialogue box prompts.

* Select the "STEREO" program on the Program Selector.

* Open the Control Center Window, and select the sample "SAWTOOTH" from the pop-

up menu in the Velocity Zone 1 and Velocity Zone 2.

* Set the pan to left channel (-50) in the Velocity Zone 1 section, and to right channel (50)

in the Velocity Zone 2 section.

* Set the High Velocity Zones (Hi V) of both Velocity Zone 1 and Velocity Zone 2 to the

maximum 127 and the Low Velocity Zones (Lo V) to 0.

* Set the Cent of Velocity Zone 2 section to 10.

* Now you can play the stereo program.

Step 10: Saving the program

To save the previously created program "TEST" to the Sampler disk;

* Open the Sampler Explorer to show the contents of sampler memory. Right click on the

program "TEST" in the Program List, and select one of the four types of save (Save.../

Clear And Save...) from the pop-up menu. Finally, selecting either the Floppy disk or

SCSI device in the pop-up menu will complete the save (The details of Save is de-

scribed in the "Sampler Explorer" Chapter.

Next, to save the last created program "STEREO" to your PC’s disk;

* Open the Sampler Explorer and right click within the Program List to see the pop-up

menu. Select the "Set Export Directory" from the menu and set where you want to save

to.

* Right click on the program "STEREO". Selecting one of the two types of export (Ex-

port...) will complete the save.

You can also save to your PC by drag and drop from the Sampler Explorer Window to

the Desk Top directly.
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Overview of MESA II Editors

About MESA II Editors

MESA II is operated in the scope of each Editor.  Those Editors supported are, the

Sampler Editor, Wave Editor and DPS Editor.  Several other Editors will be added in

future versions.  Start up MESA II.  The one of the Editor is selected from the Editors

Menu, either "Mesa Sampler Editor" or "Mesa Wave Editor".  A tick appears on the left

of the active Editor.

Some Editors automatically open one or several (empty) editing windows for you.  You

can then load a sample or program in to these windows.  By default, these windows are

left open when you load to another Editor.  You can therefore see the state of several

Editors on the same screen.  Clicking on any Editor Window activates the Editor related

to that Window.

The menu bar of MESA II changes its display according to the Editor that is active.

However, the Editors Menu and Mesa Menu are shared by both Editors.

Overview of Sampler Editor

The Sampler Editor can control almost all the functions of the AKAI Sampler.  Besides,

it can perform the import/export of samples and programs between the PC and other

external devices connected to the Sampler.

The Sampler Editor provides the following windows;

Program Selector: Programs and keygroups are selected.

Control Center: From this Window, almost all program parameters such

as output levels, filters or velocity zones are controlled.

Sampler Explorer: In this Window, all samples and programs in the Sam-

pler memory are displayed as well as the contents of

floppy disk and SCSI devices connected to the Sam-

pler.

Quick Access: Provides the layout to make the quick setting of pro-

grams and their key span.

Multi: Sets the Multi mode parameters.

Keyspan: Sets samples and their key span for each keygroup in a

program.

Mutegroups: Sets the Mute Groups in a program.

EB16: Routes the Effect and selects the Effect Set as well as

setting the parameters of each Effect.

FX Filing: Changes the name of Effects.

Furthermore, the Sampler Editor can make the exchange of the file data with the PC

easy.  The programs and samples created on the Sampler can be saved as the files on

the PC.

Use for creating and

editing the programs
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Overview of Wave Editor

The Wave Editor lets you see, playback and manipulate the Sound Samples loaded

into the Wave Editor Window.  The name of the Sample becomes the title of that Win-

dow.   This Editor has the several editing functions such as DSP editing, Zoom view,

Cut, and Paste, and the Toolbar provides an easy access to the frequently used func-

tions such as Play or Stop the sound, Enlarge or Shrink the wave form, etc.

You can have several Wave Editor Windows open.

Use for editing

samples
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Sampler Editor

In this chapter, the menu command and window of the Sampler Editor will be explained.

File Menu

Import

Transfers the wave file saved in the PC’s hard disk to the Sampler.  It can also be done

by drag and drop the file to the Sampler Memory Window (the "Import" in the menu

when right clicked in the Sampler Explorer Window does the same.).

Program Menu

New Program...

Creates the new program.  Click on  in the Tool Bar does the same (the same for

selecting the “New Program...” in the menu displayed when right-clicked in the Sampler

Explorer).

Copy Current Program...

Duplicates the current program being edited (the same for selecting “Copy Current

Program...” in the menu displayed when right-clicked in the Sampler Explorer).

Copy Current Keygroup

Duplicated the current keygroup being edited.

EB16 Menu

This Menu will be active only when the EB16 Effect board is installed in the Sampler (as

an option).

Save Effect File

Saves the Effect settings to your PC.

Load Effect File

Loads the Effect settings into EB16 from your PC.

Sampler Menu

Find Sampler...

Connects to the externally connected Sampler of your choice ( the same for click on 

in the Tool Bar).

Refresh from Sampler

Reflects the settings inthe Sampler to MESA II (the same for click on  - in the Tool

Bar).
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Editors Menu

Switches the active editor window to the Sampler Editor when the “MesaSamplerEditor”

is selected and to Wave Editor when the “MesaWaveEditor” is selected.

Mesa Menu

Configure Editors...

Restricts the access to the editors.  If the MESA II is booted up again after unchecking

the “MesaSamplerEditor”, for example, the “MesaSamplerEditor” option will not be in-

dicated in the Editors Menu and the Sampler Editor becomes unavailable.

Exit

Quits MESA II.

Help Menu

Go to AKAI Home Page

Accesses to the Home Page of the AKAI professional Web site automatically when

your PC is set up to connect via Internet.  No need to input the AKAI’s address.

About MESA...

Shows the software version number of the MESA II being operated.

Tool Bar

The available Tools in the Sampler Editor are the 9 Windows in the Windows Menu

(Control Center, EB16, etc.), “New Program...” in the Program Menu, “Find Sampler...”

and “Refresh from Sampler” in the Sampler Menu, and “Refresh SCSI drive” in the

Sampler Explorer Window.

Program Selector Window

The Program Selector Window lets you select the program and select, add and delete

the keygroups.

Program: Selects the program to be edited.  This program can be

edited on the other Windows.

Keygroups: “+” and “-” buttons let you add/delete the keygroups.

Edit group: Selects the keygroup to be edited.

When the “+” button is clicked, the new keygroup will be added to the end, and when

the “-” button is clicked, the last keygroup will be deleted.  However, you cannot delete

keygroup 1.  You can also add/delete keygroups from the Sampler Menu.

When  mark is selected, all keygroups will be edited.  If you want to edit the specific

keygroup, click on the keygroup number to select.
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Control Center Window

The Control Center Window provides almost all controls that are used to create and

edit a program from the front panel of Sampler.

The Control Center Window is divided into the several sections, and the pop-up menu

with a right-click at each section lets you choose the section to edit.  For example, the

top left section can be used as either "Output & Levels" or "MIDI Setup".

When any window, not necessarily the Control Center Window, is opened, MESA II

opens the Program Selector Window automatically.

Followings are the explanation for each section.  Refer to the Operator's Manual of the

Sampler for the function of each parameter.

The main access

Window to edit pro-

grams
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Output & Levels

This section lets you set the parameters related to the output of the program.

MIDI Setup

This section lets you set the MIDI related parameters of the program.
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Tuning & Bend

This section lets you set the parameters related to the tuning and bend of the program.

Portament

This section lets you set the parameters related to the portament of the program.

Filter 1

This section lets you set the parameters related to the Filter 1 of the program.
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Modulation

This section lets you set the parameters related to the modulation of the program.

LFO 1

This section lets you set the parameters related to the LFO1 of the program.
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LFO 2

This section lets you set the parameters related to the LFO2 of the program.

VerocityZone 1 (2, 3, 4)

This section lets you set the parameters related to the Velocity Zone of the program.
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Envelope 1

This section lets you set the parameters related to the Envelope 1 of the program.

Envelope 2 (3)

This section lets you set the parameters related to the Envelope 2 (3) of the program.

Temperament

This section lets you set the parameters related to the tuning template of the program.

Filter 2, Envelope 3, and etc. can be set if 2'nd Filter IB-304F (an option for some types

of Samplers) is installed on the Sampler.
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Sampler Explorer Window

The Sampler Explorer Window shows the programs, samples and other files (MESA II

call them as “Miscellaneous”  ) such as Effect file that are currently residing in the

Sampler memory.  It also shows you the contents of the floppy disk or the SCSI devices

connected to the Sampler.  The functions of Save and Load of the programs and samples

are operated in this window as well.

The “Information” at the top right part of the window shows;

total programs: Number of programs in the Sampler memory.

free memory: Sampler's available memory

total samples: Number of samples in the Sampler memory.

current program: Name of the current program being edited.

The contents of the Program List, Sample List and Miscellaneous List in the right side

column of the window are switched depending on the selection of the items shown in

the left column.

Memory: Program List shows the name of the program, its program

number and MIDI channel number.  The keyboard mark 

on the side of the program name appears in red when the

program is active.  To activate the other program, double click

on the program you wish to select.  To change the program

number or MIDI channel number, make the program active

first and double click on the item you wish to change.  Click

on the program name to rename it while the program is being

active.

Sample List shows all the samples residing in the Sampler

memory. The wave form mark  on the side of the sample

name appears in red while the sample is being edited.

Miscellaneous List on the bottom shows all other files resid-

ing in the Sampler memory.

Rename programs

Select programs

Set numbers and

channels

Check your Sampler's

available memory
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Floppy: Accesses to the floppy disk and shows all the programs and

samples as well as other miscellaneous files contained.

SCSI [id 5(0~7)]: Accesses to the SCSI device of the selected ID and shows

the partitions. Click on a partition accesses to that partition

and shows the volumes. Click on a volume further accesses

to the volume and shows all the programs and samples as

well as other miscellaneous files in the volume.

The pop-up menu using the right-click shows the following

functions;

Change SCSI ID: Selects the ID number of the SCSI de-

vice you wish to see.  To see its con-

tents after the change, click on the

“SCSI [id 5(0~7)]” and do the “Refresh

SCSI drive”.

Remove SCSI drive: Makes the SCSI related displays dis-

appear from the window and disables

the further access to the SCSI device

from the MESA II.

Refresh SCSI drive: Connects the MESA II with the SCSI de-

vice connected to the sampler.

While the “Memory” is being selected, the programs and samples can be drag and drop

to the “Floppy” or “Volume” in the SCSI device shown in the left column, as well as to

the DeskTop of your PC, to save (drag and drop cannot do the “Clear Save”).  The

sample can be drag and drop to the Wave edtior file list Window to edit it.  To edit a

stereo sample, select both left/right (-L/-R) samples and then drag and drop them to the

Wave edit file list Window.

To select the several items at the same time, click on the items you want while holding

the “Ctrl” key pressed.  It is also possible to select items over the lists.  This allows you

to save a certain program file with Effects file, for example.

To deselect the items, click on elsewhere, other than selected items.

While the contents of the Sampler memory are shown, the pop-up menu using the

right-click offers the following functions;

Export Selection... : Saves the selected item to the PC’s folder set in

the “Set Export Directory”.

Export Programs/Samples... : Saves the program and its samples to the PC’s

folder set in the “Set Export Directory”.

Set Export Directory: Sets the destination folder where the selected

items are saved into.  This setting remains valid

until changed.

Save Selection: Saves the selected item to the floppy disk or the

SCSI device connected to the Sampler.

Save Programs/Samples: Saves the program and its samples to the floppy

disk or the SCSI device connected to the Sam-

pler.

Check what's on the

Sampler Disk

Be careful before

you save by drag

and drop - check

what exactly has

been selected

Select Sampler par-

titions and volumes
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Clear And Save Selection: Saves the selected item to the floppy or the SCSI

device connected to the Sampler.  At this time, all

items previously resided in the destination are

erased.

Clear And Save Programs/Samples: Saves the program and its samples to the floppy

disk or the SCSI device connected to the Sam-

pler.  At this time, all items previously resided in

the destination are erased.

Import: Transfers the wave file resided in the PC to the

Sampler.  Drag and drop the file from the PC to

the Samper Memory Window also transferrs the

file (the same for the “Import” in the File Menu).

New Program... : Creates the new program.  Click on  also cre-

ates the new program (the same for the “New Pro-

gram...” in the File Menu).

Copy Current Program... : Copies the current active program.

Select All Samples: Selects all the asamples in the Sample List.

Select All Programs: Selects all the programs in the Program List.

Delete Selection: Erases the selected item from the Sampler’s

memory.

Add SCSI drive: Adds the display of the SCSI device in the left

column (available only when this has been re-

moved using the “Remove SCSI drive”).

Information: Enables/disables the Information display.

Sample Properties... : Displays the details of the selceted sample.

When saving in the “Save Selection”, “Save Programs/Samples”, “Clear And Save

Selection” or “Clear And Save Programs/Samples” option, you also select either the

Floppy or the SCSI device (its partitions and volumes shown).  To change the destina-

tion volume of the SCSI device to save, click on the volume folder in the left column (the

current destination folder is marked with a red arrow).

While the contents of the Floppy disk or the SCSI device are shown, the pop-up menu

using the right-click offers the following functions;

Load Selection: Loads the selected item to the Sampler memory.

Load Programs With Samples: Loads the program and its samples to the Sam-

pler memory.

Clear And Load Selection: Loads the selected item to the Sampler memory.

At this time, all items previously resided in the

Sampler memory are erased.

Clear And Load Programs/Samples: Loads the program and its samples to the Sam-

pler memory.  At this time, all items previously

resided in the Sampler memory are erased.

Create New Volume: Creates the new volume in the current active par-

tition.

Load selected items

into memory
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Select All Programs: Selects all the programs in the Program List.

Select All Samples: Selects all the asamples in the Sample List.

Delete Selection: Erases the selected item from the Sampler’s disk.

Add SCSI drive: Adds the display of the SCSI device in the left

column (available only when this has been re-

moved using the “Remove SCSI drive”).

Programs: Enables/disables the Program List display.

Samples: Enables/disables the Sample List display.

Miscellaneous: Enables/disables the Miscellaneous List display.

Information: Enables/disables the Information display.
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Quick Access Window

The Quick Access Window provides an easy access to the key parameters in all pro-

grams and keygroups in the Sampler, the main window for mixing.

All the programs in the Sampler are shown in the Program Field.  Click on a triangle

mark beside the program name shows its keygroup parameters.

The various parameters, such as program number, MIDI channel, L/R  stereo volume

and balance, individual output levels, output assignment and tuning can be changed

here (the pop-up menu with the right-click in the window enables/disables the display

of velocity zones 1~4).

You can navigate around these parameter fields either by mouse, Cursor keys or Tab

key.

To change individual parameter values, double click on the field you want to change

first, and then use the mouse to drag the control or use the Enter key to type in the

value directly.  You can also press + and - keys to nudge the values stepwise up or

down.

The main access

window for mixing

programs

Quickly access a

program's key pa-

rameters

Multi Window

The Multi Window sets the multi mode parameters of the Sampler.

The manipulation of this window is the same as that of the Quick Access Window.
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Keyspan Window

This window is used to assign the samples, their keyspan, and their velocity zone for

each keygroup in a selected program.

On the keyboard at the top of Window, click on a note key will play the sample.

The setting is performed on each keygroup.  To enable/disable the display of velocity

zones 1~4, use the four buttons on the side of the keyboard.  Setting items are as

follows;

Kg: Keygroup number

lo(hi): The key range can be typed from the keyboard.

zn: Velocity zone number.  By checking in the pop-up Visible Zone

Menu with right-click, the unnecessary zones can be hidden.

Sample: Assign the samples in the Velocity Zone 1 to 4.

Span bar: Sets the key range by dragging the left/right edge of the bar

with mouse.  Dragging the center of bar shifts the range with-

out changing its width.  The current range of note is displayed

at the “lo (hi)”.

lo (hi) V: Sets the velocity range of each Velocity Zone.

Pitch: Sets the constant pitch of each Velocity Zone.

To duplicate the keygroup, select the “Copy Current Keygroup” from the Program Menu.

Mute groups Window

The Mute groups Window lets you set the Mute Groups in a program.

The keygroups in a program are grouped into 32 Mute Groups.  Those keygroups
grouped in the same Mute Group number mute each other.  This function is mainly
used for special effects or drum kits.

With the program that plays several sounds simultaneously, you sometimes want to
override the polyphonic function and play only one sample.  For instance, if you want to
follow an open high hat with a closed one, you might want to stop the first one as soon
as the second one plays.  To do this, just assign both samples to the same mute groups,
other than 0.  This makes the group monophonic and the open high hat will stop playing

as soon as the closed high hat, i.e. another sample in the same mute group, is played.

Assign key spans

Select velocity zones

Duplicate keygroups



28  The Sampler Editor MESA II

EB16 Window

The EB16 Window sets the input/output parameters of four Effect buses.  It is also used

to set the Effect and its routing to the current program.  Note that these Effect related

windows are available only when the EB16 Effects Board is installed in your Sampler.

Editing: Selects the Effects Set or Reverb to edit.

Mute: Switches On/Off the bus output.

External Input: Selects the bus connection of Left/Right sam-

pling input.  Enables you to use the EB16 as

an Effect unit for the external sound sources.

Output: Sets the output of Effect (output connector on

the Sampler's rear panel).

Program FX bus: Sets the Effect bus routing and its level for the

current program.

Keygroup FX bus: Sets the Effect bus routing and its level for the

current keygroup.  The setting here has the

priority over “Program FX bus” setting.  If “PRG”

is selected, the “Program FX bus” setting is

used.

Effect/Reverb pop-up menus: From this pop-up menu, you select the Effect

and Reverb sets to assign to each Effect bus.

If you change the FX1 or FX2 set, RV1 and

RV2 may be changed automatically.  It is be-

cause RV1 and RV2 are linked together with

FX1 and FX2.

The Effect related

windows open up

only when the EB16

Effect board is in-

stalled in the Sam-

pler.
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FX Routing dial: Sets the bus control of Effect.  A negative value

sets the level of signal from the Reverb passed

onto the Modulation/Echo section.  A positive

value sets the level of signal from the Modula-

tion/Echo passed onto the Reverb section.  If

the value of  0 is set, the Modulation/Echo and

Reverb become independent and they are used

in parallel connection.

Dir Signal: Switches on/off of the direct (dry) sound.

Distortion/EQ: Sets the ouput level and PAN of the Distortion

Module and EQ Module combined.

Modulation/Echo: Sets the output level and PAN of the Modula-

tion Module and Delay/Echo Module combined.

The Width controls the expanse of the stereo

effect.  Setting this to 0 makes the effect mono.

Rev1 2, Rev3 4: Sets the output level and PAN of the Reverb

Module.  While the FX1 or FX2 is selected in

edit, the “Rev1 2” is adjustable.  When the RV3

or RV4 is selected, “Rev3 4” is adjustable.

Selecting RV1 or RV2 has no effect.

The Effects in the EB16 Window are divided into the several sections, similar to the

Control Center Window, and the pop-up menu with a right-click at each section lets you

choose the effect you wish to edit.

4 Band EQ

The 4 Band EQ section sets the Equalizer parameters.

Freq: Sets the EQ frequency

Level: Sets the EQ level

Width: Adjusts the Q of filter

Fmod: Sets the modulation frequency

Depth: Adjusts the amount of sweep.

Bypass: Bypasses this module.

Made with the high

range high-cut filter,

mid-range band-

pass filters, and low

range low-cut filter.

The modulation is

conducted in the

middle range filter,

and you can originate

the "auto-wah" Ef-

fect.
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Modulation

The Modulation section sets the modulation parameters.

There are 5 types of modulation functions available; one can be used selecting from

the pop-up menu with the right-click.

   Phase/Flange/Chorus

Mode: There are 3 types; the Phaser, Flanger, and Chorus

Speed: Adjusts the speed of phase Effect

Depth: Sets the amount of Effect

Feedback: Adjusts the amount of feedback from the Effect output to input

   Rotary Speakers

Speed1/2: Sets the rotation speed of Rotary Speaker

Initial Speed: Sets the initial speed of Rotary Speaker effect: Speed 1 or 2.

Accel: Sets the time to take to switch between Speed 1 and Speed 2.

Depth: Sets the amount of Effect

MIDI Control: Sets the MIDI channel and MIDI Controller to allow switching

the rotation speed via MIDI.

The Phaser brings

the sound with so

called "swooshing"

Effect. The Flanger

also gives the sound

with the "swooshing"

Effect, but brings

more deep sound.

The Chorus gives

the effect like the

several music instru-

ments are simulta-

neously played.

Simulates the sound

of Rotary Speaker
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   Freq Mod/Auto Pan

   <FMod>

Speed: Adjusts the modulation frequency

Depth: Adjusts the amount of Effect

Feedback: Adjust the feedback amount

   <Auto Pan>

Speed: Adjusts the panning speed between the left and right

Depth: Adjusts the width of pan Effect

Mode: Sets the type of Effect

   Pitch Shift

Semi: Sets the amount of shift in semi-tone step

Cent: Sets the amount of shift in cent (1/100 of a semi-tone) step

Experiment the Vi-

brato, Doppler effect,

etc.

Makes up the pitch

shifted sound to the

original sound
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   Pitch Shift + Fdbk

Semi: Sets the amount of shift in semi-tone step

Cent: Sets the amount of shift in cent (1/100 of a semi-tone) step

Delay: Sets the delay time

Feedback: Sets the feedback amount

Ring Mod/Distortion

The Ring Mod/Distortion section sets the Ring Modulator and Distortion parameters.

Freq: Sets the modulation frequency

Depth: Set the depth of Ring Mod Effect

Distort: Sets the amount of Distortion

Output: Sets the output level of Distortion

Bypass: Bypasses this module.

Adds the delay effect

on the pitch shift

The Distortion simu-

lates the distortion as

if the input signal is

overloaded.

The Ring Modulator

is an Effect of the in-

put signal being

modulated by the in-

ternal oscillator.  Ex-

periment the sound

without any metallic

sound.
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Delay/Echo

The Delay/Echo section sets the Delay/Echo parameters.

There are 4 types of Delay/Echo functions available, Mono L, Mono LR, Crossover LR,

and Stereo; one can be used selecting from the pop-up menu with a right-click.

Delay: Adjusts the delay time

Feedback: Adjusts the feedback amount

HF Damp: Sets the filter frequency to filter out the high frequency com-

ponent contained in the feedback signal

Offset: Sets the amount of offset for the feedback signal

Output: Switches the module output; Pre/Post

Reverb

The Reverb section sets the Reverb parameters.

There are several types of Reverb functions available; one can be used selecting from

the pop-up menu with a right-click.

Time: Adjusts the time it takes to diminish the reverb signal

Pre-Delay: Adjusts the delay time of the reverb signal referenced to the

input signal

Diffuse: Sets the amount of diffusion in the reflected sound

Near: Adjusts the distance from the original sound source

LF Damp: Cuts out the low frequency component of the reverb sound

HF Damp: Cuts out the high frequency component of the reverb sound

Widens the sound by

overlapping the de-

layed sound to the

original sound

Adds reverb to the

original sound
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FX Filing & Naming Window

This window will let you rename the Effect and Reverb names, and also copy, save and

load the files.

FX Filename: Name of Effect file.  Click it with mouse to rename it.

Effects: List of Effect set.  Click it with mouse to rename it.

Reverb: List of Reverb set.  Click it with mouse to rename it.

In this FX Filing & Naming Window, you can copy the Effect set and the Reverb set to

the other set by drag and drop.  However, copying the Effect set to the Reverb set or

copying the Reverb set to the Effect set is not possible.

Controls the Effect

file
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Wave Editor

In this chapter, the Menu Commands and Windows regarding the Wave Editor will be

explained.

Selecting the “MesaWaveEditor” from MESA II Editors Menu changes to the Wave

Editor.

File Menu

New

Creates a new Wave Editor Window.  You set the name, sampling rate and select the

mono/stereo mode at the same time.

Open...

Opens a wave file saved in your PC.

Close

Closes the active Window.

Save

Saves an Wave file in the current active Wave Editor Window to the PC.  The file with

the same name will be overwritten.

Save As...

Saves an Wave file in the current active Wave Editor Window to the PC with a different

name.

Info

Lets you write the details and commments of the Wave file in the current active Wave

Editor Window.

Exit

Quits MESA II.
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Edit Menu

Undo

Allows you to undo the last edit operation.

Copy

Copies selected portion of wave data to the clipboard.

Paste

Pastes wave file copied from the clipboard into the same Wave Editor Window, or

another Wave Editor Window.  The start of Pasted is the insertion point of the Cursor.

The Paste function works even if the copy destination file is shorter than the copy file

(but the excessive portion is not copied).

Cut

Deletes the selected area of the wave data.

Crop

Removes the wave data before the start and after the end of the selected wave data.

Select all

Selects the entire wave data in the active Wave Editor (double-click on the wave form

does the same).

Select Loop

Selects the area between the Loop Start Point and Loop End Point.

Select Start to End

Selects the area between te Start Point and End Point.

Deselect

Cancels the current selected wave data.

Play Clipboard

Plays back the wave data pasted on the clipboard by Copy function.

Selection to Loop

Sets the loop points to make the selected area loop.  This moves the Loop Start Point

and Loop End Point to the start and end points of the selected area.

Selection to Start + End

Sets the Start Point and End Point to the start and end points of the selected area.
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View Menu

The View Menu sets the parameters of Wave Editor display.

Overview

Opens and closes the Overview display box at the top of the Wave Editor Window.

File List... (Wave editor file list Window)

Opens and closes the Wave editor file list Window.  The sample loaded in the Sampler

memory or the wave file saved in the PC can be drag and drop to this Wave editor file

list Window to open up the Wave Editor Window.  Also, the renaming of the file is done

here.

Fit

Fits the selected wave area into the Edit Area of the Wave Editor Window.  If the area is

not selected, the entire sample is displayed.

Start

Shows the start portion of the selected wave area in the center of the Edit Area window.

End

Shows the end portion of the selected wave area in the center of the EditArea window.

Zoom In

Enlarges the wave form in time scale at the center of the Edit Area.

Zoom Out

Shrinks the wave form in time scale at the center of the Edit Area.

Points / Seconds / Millisecs

Sets the time display style of the Ruler of the active Wave Editor Window.

Colours

Sets the colours used in the Wave Editor Window.  The selectable colours are “Back-

ground...”, “Sample...”, “Selection...”, “Center Line...” and “Guide Line...”.  To reset the

colours to their default settings, select the “Reset To Default”.

Set you Ruler Style

Choose your colours
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Window Menu

Cascade

Sets the multiple windows, including the Sampler Editor Window, to be displayed in

cascaded fashion.

Tile

Sets the multiple windows, including the Sampler Editor Window, to be displayed over

the entire screen.

Sound Menu

Play

Plays back the sample in the current active Wave Editor Window.  When the Loop is not

set, the playback stops at the End Point of the Sample.  When the area is selected, only

the selected area is played back.

Stop

Stops the playback of the Sample play.

Loop Selection

To playback the selected area in Loop Play (Check on the Loop Selection and use the

Play to actually play it back in loop).

Enable Looping

Enables and disables the loop setting designated by the Loop Start Point and Loop

End Point.

Playback Device...

Selects the Sound Card used in the PC to playback the wave data by the Wave Editor.
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DSP Menu

The DSP Menu contains various Digital Signal Processing functions.

The DSP options currently include the functions such as the Sound Increase/decrease

by 3dB, Wave Analysis, Filters for EQ, High/Low Pass and Fade, Level Normalization,

Wave Reversal and Inversion, and Time Stretch.

Select the editing part and channel first, then use this DSP functions.

Note that the DSP functions are only performed on the selected part of the Wave Editor

Window.  If you want to use DSP on the whole sample, you must select the whole

sample (press Ctrl+A, or double click on the Wave form to do so).

Each function is described as below:

Adjust Amplitude

Adjusts the level gain of the wave form by percentage.

Analyse

Shows the results of a fast Fourier Frequency Analysis.

First select the edit-

ing part and channel,

then use DSP.
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Expander Limiter

Expander and Limiter.  The singal level expansion or limiter effects performed to the

wave data.

Graphic EQ

7 band graphic equalizers.  Use the mouse to adjust the individual filter.

Fade

Allows you to fade in/fade out in either linear (Lin), logarithmic (Log) or inverse logarith-

mic (InverseLog) form.
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Filter

Sets the cutoff frequency to cut the lower or higher frequency component of sound.

The High Pass (cuts off low frequency component) and Low Pass (cuts off high fre-

quency component) Filters are integrated into one window.  Select the filter type and

select the filter slope of either 6dB/Oct or 12dB/Oct.

Invert

Inverts the wave form up side down.

-3dB / +3dB

Decreases or increases the level of wave form.

Normalise

Optimizes the amplitude of wave form.  Maximizes the highest amplitude wave form.

Reverse

Reverses the wave form front side back.

Silence

Makes the signal level to zero (no sound).

Time Stretch

Extends or shortens the time axis without changing the musical tone.
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Original Length: Sample Points (Sample Length) of the original sample.

Required Length: Sample Length after performing the Time Stretch.

Type: Selects the type of sound source.

Quality: Selects the quality of Time Stretch.  It will take a longer time

at “Best” selection.  It takes less time in “Quick” mode, but

the quality of sound is not as good as that of “Best”.

Instead of specifying the number of Sample Points directly, you can press “%” button to

specify the expansion/compression ratio to the original sample.  With the B.P.M button,

you can set the Sample Length by specifying the number of beat (tempo) per minute

and the number of beat in one measure.

Tool Bar

The Tool Bar in the Wave Editor provides the tools for “Play” and “Stop” in the Sound

Menu and “Zoom In”, “Zoom Out”, “Start”, “Fit” and “End” in the View Menu.  It also

provides “Increase wave height” and “Decrease wave height” tools.

Play with four types

of Zoom in/Zoom out

Buttons - No change

to the sample itself.

Help Menu

The same as the “Help Menu” in the Sampler Editor chapter.

Mesa Menu

The same as the “Mesa Menu” in the Sampler Editor chapter.

Editors Menu

The same as the “Editors Menu” in the Sampler Editor chapter.
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Wave Editor Window

Title Bar: Displays the sample name.

Ruler: Shows the location in the unit specified in the View Menu.

Overview Area: Shows the whole sample wave form.  The area shown in

the Edit Area appears by surrounded dotted line.

Edit  Area: Shows the sample wave form for editing.  Possible to en-

large/scale down the display.  When a stereo sample is

edited, the Left channel is shown in the upper area while

the Right channel is shown in the lower.

Information Area: Shows, from left to right, “Sample Bit”, “Sampling Rate/

Frequency”, “Sample Length”, “Cursor Position”, “Start

Point of selected area”, “End Point of selected area” and

“Length of selected area”.

Start Marker: Shows the start point of sample play.

End Marker: Shows the end point of sample play.

Loop Start Marker: Shows the start point of loop.

Loop End Marker: Shows the turning point of loop.

Drag Icon: Drag this icon and drop it onto the Desk Top of the PC or

the Sampler Memory to save the wave data.

Overview Area and

this shows the se-

lected area in the

Edit Area.

The main access

window for editing

samples

Tools are described

in the Toolbar section

above

Displays the infor-

mation about the

sample being edited

Select a Tool and

edit a sample with it
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Drag and drop the Audio file (wave file) on your PC or the sample on the Sampler

Explorer (shown in the middle of right column when the “Memory” in the left column is

clikced) into the Wave editor file list Window to open the wave form in the Wave Editor

Window.

You can also open the file using “Open...” in the File Menu.

When the sample file is opened, the  Wave Editor Window shows the sample wave

form and the name of sample in the title bar.

The Audio Editor Window is split into two sections: the Overview Area on top and the

Editor Area below.  You can turn the Overview display on/off using the “Overview” in the

View Menu.

Moving the Triangle Marker sets the start and end point of sample.

Moving the Pentagon Marker sets the start and end point of loop.

You can select the “Play/Stop” from the Sound Menu or press the Spacebar to play/

stop the selected audio in the Wave Editor Window (Play/Stop tools in the Tool Bar do

the same).

For a stereo sample, the left channel is shown on top and the right channel is shown

below in one Wave Editor Window.  When a stereo wave file on your PC or a stereo

sample on the Sampler is opened, it opens as one stereo file.  A stereo sample in the

Sampler is divided into left and right sample files.  When you drag and drop the 2 mono

samples of the same name with “-L/-R” suffix on their end to the Wave editor file list

Window at the same time, they are automatically taken as a stereo file.

If you want to select and edit one side of a setero sample, move the cursor to either

upper or lower half of the Edit Area.  Moving the cursor to the upper half of the Edit Area

makes the small letter “L” to appear on its side and moving it to the lower half makes it

with the letter “R”.  While this small letter is displayed, you can select one side of a

stereo sample.  If the cursor is placed in the middle, it selects both samples.

To save the audio data from the Wave Editor Window, drag the Drag Icon located at the

right top corner of the Overview Area onto the save destination (the same when “Save”

from the File Menu is selected).  Also, the file name can be renamed by clicking on the

file in the Wave editor file list Window before saving.

If a stereo sample is saved to your PC from the Wave Editor Window, it will be saved as

one stereo wave file.  If you drag and drop a stereo sample directly from the Sample

Memory to your PC, it will be saved as two separate mono (-L/-R) files.

To make it visually more apparent what you are editing, use the Zoom Tool to expand or

shrink the visual display of the sample you selected.  Using the “colours” in the View

Menu, you can even change the colour scheme of sample and background.

You can now make up the sample to meet your purpose using DSP functions.

Load mono or stereo

samples

Spacebar does the

Play/Stop functions

Drag the loop mark-

ers to adjust the loop

point
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The following shows the function menus appear when the mouse is right clicked in the

Edit Area and on the Markers.

In the Edit Area;

Zoom To Here: Enlarges display of the clicked area to maximum.

Fit: Shows the selected area in the Edit Area. If the

area is not selected, the whole sample is displayed.

Play From Here: Starts to play from the clicked point.

Selection Start/End: Selects the Start/End point of wave data selection.

It merely selects the area, but the actual Start/End

Points are not affected.

Set Start/End Marker: Moves the Start/End Marker to the clicked point.

Set Loop Start/End Marker: Moves the Loop Marker to this clicked position. If

no Loop Marker is present, it creates the new one.

Make New Marker: Makes the new marker. This marker is not relevant

to the Start/End/Loop markers.

On the Marker;

Zoom To Marker: Enlarges the display of the marker area to maxi-

mum.

Lock: Locks the position of the marker and turns the

marker red.

Unlock: Unlocks the “Lock”.

Remove Marker: Deletes the marker clicked. Not available for the

Start/End Markers.

Select to Next Marker: Selects from the marker clicked to the next marker.

Select to End: Selects from the marker clicked to the End Marker.
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